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 مقدمه
WinCC – Windows Control Center می باشد.ویندوز  قابل نصب بر روی 

 

WinCC  .یک سیستم ماژولار استWinCC  برای نمایش وضعیت پروسه و پیکربندی رابط های کاربری

 گرافیکی استفاده می شود.

 

 در اختیار شما قرار می دهد عبارتند از: WinCCامکاناتی که 

- WinCC ازه می دهد که پروسه را مشاهده نمایید.پروسه بصورت گرافیکی در به شما اج

بصورت مرتب  Cycle Timeصفحات نمایش داده می شود. اشکال و مقادیر در هر 

Update .می شوند 

- WinCC  به شما اجازه می دهد که اپراتور را با پروسه درگیر نمایید برای مثال اپراتور می

 ها را از طریق رابط های کاربری با تغییر دهد.  SetPointتواند با داشتن مجوز مقادیر 

- WinCC سیگنال های مربوط به آلارم ها به شما اجازه می دهد که پروسه را مانیتور نمایید .

 بصورت اتوماتیک و در مواقع بحرانی ظاهر خواهند شد و وضعیت پروسه را نشان خواهد داد.

- WinCC ه را آرشیو نمایید، وقتی به شما اجازه می دهد که مقادیر پروسWinCC  در حال

کار است مقادیر می توانند ارشیو شوند، این امکان موجب می شود شما مدارکی از مقادیر 

 تولیدی پروسه داشته باشید.

 

WinCC  یک نرم افزار قدرتHMI  .برای استفاده در مایکروسافت ویندوز می باشدHMI  مخفف و خلاصه

به معنی رابط میان انسان)اپراتور( و ماشیین )پروسیه( میی باشید.      Human Machine Interfaceشده 

WinCC .هم با اپراتور و هم با سیستم اتوماسیون ارتباط دارد 

 

 WinCCپیکربندی و توسعه پروژه های 
کیه در    Runtime Software(RT)و  Configuration Software(CS)عبارتنید از   WinCCاجیزای  

 خواهند شد.ادامه بیشتر توضیح داده 

 

 

Configuration Software   
 

نمایش و پیکر بندی می شود و همپنیین میدیریت پیروژه در ایین      WinCC Explorer ساختار پروژه در 

محسوب می گردد و  Configuration Software بنابراین به عنوان هسته اصلی   قسمت صورت می گیرد

 اصی را دنبال می کند.های متنوعی است که هر کدام وظیفه خ Editorشامل 
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د نی مخصوص که توانایی بسییار زییادی دار   Editor تعدادی WinCCبرای پیکربندی و توسعه پروژه های 

 .گرد هم آمده اند  WinCC Explorerبصورت مجتمع در نرم افزار فراهم گردیده است 

کدام از آنها نیز زیر مجموعه ها بخشی از پروژه پیکربندیمی شود و هر  Editor با استفاده از هر کدام از این

 .دندارهای خاص خود را 

 

 

 در زیر آورده شده اند: ها  Editorمهمترین  

 
-Designer   Graphic  : برای ساخت صفحات 

- Alarm Logging  برای ساخت و پیکربندی پیغام ها : 

-  Tag Logging برای آرشیو مقادیر تگ ها : 

-Designer  Report ارشات: برای ساخت گز 

- Tag Management برای ساخت تگ ها : 

- User Administration  برای ایجاد و ویرایش کاربران و دادن مجوز های لازم در :WinCC 
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Runtime Software 

 
بیه   Runtimeمی باشید. در واقع  Runtimeمی نمایید شما در حالت  Activateرا  WinCCوقتی پروژه 

به صورت زیر میی    WinCC Runtimeتورینگ پروسه را می دهد.وظایف عمده شما اجازه مشاهده و مانی

 باشد:

  DataBaseخواندن داده های پیکربندی از  -

 نمایش صفحات -

 ارتباطات با کل سیستم اتوماسیون -

 آرشیو سازی مقادیر تگ های مشخص شده و همچنین نمایش آلارم های مرتبط با تگ ها -

 ON-OFFها و کلیک بر روی کلیدهای  Setpointتعیین مقادیر  کنترل پروسه، -
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 توجهات:

 توضیحات آیکون

 

 نشان دهنده کلیک چپ ماوس

 

 نشان دهنده کلیک راست ماوس

 

 نشان دهنده دابل کلیک

 

 نشان دهنده ورودی از طریق صفحه کلید

 

 فشار دادن و گرفتن دکمه چپ ماوس

 

 رها کردن دکمه چپ ماوس

 

 درگ کردن توسط دکمه چپ ماوس

 

 شماره مرحله اکشن
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 فصل اول
 آماده سازی و نصب:

 
 آشنا خواهید شد. WinCCدر این فصل با سخت افزار و نرم افزار مورد نیاز جهت نصب و راه اندازی 

 WinCCموارد موردنیاز جهت نصب 

 دنیاز می باشد که در ادامه ذکز خواهند شد.نرم افزار و سخت افزار خاضی مور WinCCبرای نصب 

 نرم افزار هایی می بایست قبل از آن نصب شده باشند که در زیر ذکر می شوند: WinCCدر طول نصب 

 

 سیستم عامل مناسب -

 درستی تعریف کاربران -

 تعیین درست وضوح تصویر -

 Internet Explorerنصب  -

 MS Message Queuing Servicesنصب  -

 SQL Serverنصب  -

 ریست کامپیوتر -

 

 

 

بر  WinCC 7و   2000و ویندوز  SP 2,3   XPفقط بر روی ویندوز WinCC 6 SP4توجه : 

 قابل نصب هستند. 7و ویندوز  XP SP3روی ویندوز 
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 WinCCمواجه با پیغام های خطا در هنگام نصب 
 

شما انجام نگرفته باشد، نصیب   بر روی سیستم WinCCاگر حداقل یکی از موارد زیر قبل شروع نصب 

WinCC      انجام نخواهد شد و با یکی از پیغام های خطا ی زیر مواجه خواهید شید کیه در جیدول زییر

 اطلاعاتی در مورد این پیغام ها آورده شده است:

 راه حل پیغام خطا
To perform a proper installation, the 
computer has to be restarted 

 

ری را نصب کرده بودید که نیاز به ریست شما نرم افزا

 WinCCشدن داشته و اکنیون بیه هنگیام نصیب     

 کامپیوتر ریست می شود.
Win XP / Win 2000 SP2 operating 
system required 

 

شما می بایست سیستم عامل کیامپیوتر خیود را بیه    

 ارتقا دهید. 2سرویس پک   2000یا  XPویندوز 

This application requires VGA or 
higher resolution 

 

تنظیمات مربوط به مانیتور بررسی شودو ییا دراییور   

 می باشد Upgradeمربوط کارت گرافیک نیازمند 
Administrator rights are required to 
install this product 

 

مییی بایسییت در میید کییاربری    WinCCنصییب 

Administrator .صورت پذیرد 

The Microsoft Message Queuing 
Services are not installed 

 

میورد نییاز    Message Queuing Servicesنصب 

 می باشد

The required SQL Server 2000 SP4 
instance is not installed 

 

میورد نییاز میی     4سرویس پک  SQl Serverنصب 

 باشد

 

 

 سخت افزارهای موردنیاز نصب: -1-1

 تجهیز حداقل پیشنهاد
MHz Intel Pentium 4,1400 MHZ CPU Intel Pentium III, 800  CPU 

1 GB 512 MB Main Memory 

10 GB 1.5 GB Available Hard Disk Space 

1.5 x Main Memory 1.5 x Main Memory Virtual Memory 

>100 MB 100 MB Memory for the Window 
Printer Spooler 

32 MB 16 MB Video Card 

True Color 256 Color Depth 

1024x768 800x600 Resolution 
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 نرم افزار های موردنیاز: -2-1
 MS Message Queuingو   SP4  SQL Server 2000میی بایسیت   WinCCقبل از شروع به نصیب  

Services را نصب نمایید. 

 سیستم عامل: -1-2-1

 سیستم عامل پیکربندی پیشنهاد
If you install Windows XP 
Service Pack 1, the Internet 
Explorer 6.0 Service Pack 1 
will 
be installed as well. 

 

Windows XP Professional or 
Windows XP Professional 
Service Pack 1 

 

Windows XP 

 

 Windows 2000 Professional 
Service Pack 2 or 3 

 

Windows 2000 

 

 

 اینترنت اکسپلورر: -2-2-1
یا  1سرویس پک  Microsoft Internet Explorer 6.0، نصب  WinCCیکی دیگر از پیشنیازهای نصب 

زیر را حتمیاً بیرای    موارد Internet Explorerبالاتر می باشد)معمولاً نصب شده می باشد( در هنگام نصب 

 :رعایت نماییدنصب شدن 

 Installation Option: Standard Installation- 

Update of the Windows Desktop: No- 

Active Channel Selection: None- 

    Javaمیی بایسیت گزینیه    نیز داشته باشیید  Htmlرا د رقالب  WinCCنرم افزار  Helpاگر می خواهید 

Scripts   را در قسمتInternet Options .نیز برگزینید 

 

3-2-1- Microsoft Message Queuing Services 

فرض بر روی این کامپوننت بخشی از سیستم عامل شما محسوب می شود، این سرویس بصورت پیش 

را نصب نمایید لازم است این سرویس  WinCCسیستم شما نصب نیست بنابراین در صورتی که بخواهید 

 مطابق روش زیر نصب شود:

 سی دی نصب ویندوز را در سی دی رام قرار دهید.
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 مراحل نصب:

 مراحل 

1 Start>Settings>Control Panel>Add/Remove Programs 

کلیک نمایید تا منویی به شکل  Windows Components Wizardروی دکمه از سمت چپ  2

 زیر ظاهر شود:

 
3 Message Queuing  را تیک زده و بروی دکمهNext کلیک نمایید 

 را کلیک نمایید Finishپس از پایان نصب این کامپوننت دکمه  4

  

4-2-1- Microsoft SQL Server 2000 
ایین نسیخه مخصیوص    بر روی سیستم شما نصب باشد ولی  SQL Serverاز  در صورتی که حتی نسخه ای

WinCC  نباشد شما نیازمند به نصبSQL Server SP4  محصولی از شرکت مایکروسیافت و  (خواهید بود

 (WinCCمخصوص نرم افزار 
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 و تنظیمات آن: WinCCنصب  -5-1
اتوران منوی نصب آن ظاهر شود، اگر به هیر   را در سی دی رام قرار داده تا بصورت WinCCسی دی نصب 

 را بصورت دستی از سی دی رام اجرا نمایید.« Start.exe»دلیل برنامه اتوران اجرا نشود فایل 

 پس از سپری شدن مدت زمان کوتاهی دیالوگ زیر ظاهر خواهد شد:

 
 

 مراحل نصب:

را یکی پس از دیگری کلیک نمایید.مراحل نصب « Install SIMATIC WinCC»بر روی گزینه  -1

 با استفاده از کادرهای ظاهر شده سپری کنید.

 را کلیک نمایید Nextداده های مورد نیاز را وارد نماییدو دکمه  User Registrationدر کادر  -2
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را انتخاب نمایید و  Englishظاهر می شود که می بایست زبان  Select Languageدر ادامه کادر  -3

 ایید.را کلیک نم  Nextدکمه 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

در  WinCCظاهر می شود، شما سه گزینه پایه برای نصیب   Select Componentsدر ادامه کادر  -4

 را انتخاب نمایید User-definedاختیار خواهید داشت، برای نصب همه کامپوننتها گزینه 
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وننیت هیای   ظاهر می شود شما میی بایسیت کامپ   Select Componentsدر ادامه کار نصب کادر  -5

موردنیاز خود را انتخاب نمایید در کادر پایین توضیحات مربوط به هریک از ایین کامپبوننتهیا را در   

صورت کلیک ماوس بر روی آن مشاهده خواهید نمود، پس از انتخاب کامپوننتهیای موردنییاز روی   

 کلیک نمایید  Nextدکمه 
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کامپوننتهیای انتخیابی در مرحلیه قبیل      ظاهر می شود، در این کادر مجوز Authorizationکادر  -6

بصورت لیست ظاهر خواهند شد، شما می توانید این مجوزها را بعداً نیز نصب نماییید)پایان نصیب   

WinCC)   بنابراین گزینهNo,perform the authorization later  را برگزینید و دکمهNext 

 را کلیک نمایید.

نیاز برای بازگشت به را بزنید و در صورت  Nextها دکمه در ادامه مراحل نصب با پدیدار شدن کادر  -7

 کلیک نمایید. Backکادر قبل روی دمه 

 Yes, restart computerکادری ظاهر خواهد که میی بایسیت گزینیه     WinCCدر پایان نصب  -8

now .را جهت ریست کامپیوتر برگزینید 

 

 WinCCروش نصب کامپیوننت پس از نصب 

قصد داشته باشید یک یا پند کامپیوننت را نصب نمایید مراحل زییر    WinCC در صورتی که پس نصب

 را دنبال نمایید:

 مراحل 

1 Start>Settings>Control Panel>Add/Remove Programs 

را کلییک   Change/Removeرا انتخاب نمایید و دکمه  SIMATIC WinCC V6.0از لیست  2

 سروع خواهد شد WinCCنمایید. برنامه نصب 

را در سیی دی   WinCCدر صورتی که قصد نصب کامپبوننت های دیگری را دارید سی دی نصب  3

 رام قرار دهید

 بقیه مراحل را دنبال نمایید. 4
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 دومفصل 

 WinCCاولین پروژه 
 

 

را معرفی نموده و یک نگیاه کلیی از مهمتیرین ویرایشیگرها      WinCCاین فصل به شما مشخصات اساسی 

(Editorsآن را با ) .یک کاربرد ساده فراهم می نماید 

 عملیات زیر را انجام دهید: WinCCبرای ایجاد یک پروژه با 

 

 .ایجاد نمایید WinCCدید جابتدا یک پروژه  .1
 ها یا دریورهایی را تصمیم به نصب و استفاده از آن را دارید. PLCتعیین نمایید که کدام  .2

3. Tag  ها را برایPLC .ها تعریف نمایید 

 د را ایجاد نمایید.تصاویر خو .4

 ( خود را تنظیم نمایید.Runtimeمحیط اجرایی ) .5

 اجرا نمایید. WinCCرا در محیط اجرایی  صفحات .6

7. Simulator .را برای تست صفحات فرایند استفاده نمایید 

 

 

 

 WinCCاجرا کردن  -مرحله ا -1-2

 این نرم افزار را اجرا نمایید. Start → SIMATIC → WinCCاز مسیر 

 ساخت یک پروژه جدید -2رحله م 2-2

را برای اولین بار اجرا می کنید، دیالوگ باکسی مشابه شکل زیر نمایش داده می شیود کیه از    WinCCاگر 

 شما می خواهد تا یکی از حالتهای زیر را انتخاب نمایید:

 (Single-User Projectایجاد یک پروژه برای یک کاربر منفرد)انتخاب پیش فرض( ) -

 (Multi-User Projectرژه چند کاربره )ایجاد یک پ -

 (Client Projectایجاد یک پرژه مشتری ) -

 (Open an Existing Projectباز کردن یک پرژه موجود ) -
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 ساخت پروژه:

 

 را کلیک نمایید. OKرا انتخاب و دکمه  Single-User Projectگزینه  -1

انتخاب نمایید.شیما میی توانیید در صیورت لیزوم       تایپ کرده و مسیر آن را QuickStartنام پروژه را  -2

 زیرشاخه ذخیره پروژه را نیز تغییر نام دهید.

را از کادر دیالوگ بالا انتخاب تا  Openاگر شما می خواهید پروژه ای را که قبلاً موجود بوده باز نمایید دکمه 

را اجرا می نماییید آخیرین    WinCCرا بدهد. در دفعات بعد که   mcp.به شما اجازه انتخاب فایل با پسوند

 باشد  Activateباز خواهد شد.اگر پروژه در حالت  تیکامر روی آن کار کرده اید بصورت اتوپروژه ای را که ب

 Activateرا باز می نمایید همان پیروژه بیه حالیت     WinCCخارج شوید، دفعه بعد که  WinCCو شما از 

  خواهد رفت.

 

ری است که جهت انجام مراحل مختلف پروژه استفاده می شود.زیر شاخه ها سمت چپ پنجره شامل ابزار ناوب

 با علامت + نشان داده شده اند که با کلیک بر روی آن این زیر شاخه ها نشان داده می شوند.

 انتخابی را نمایش می دهد. Editorاجزای وابسته به سمت راست پنجره 

 

 

 PLC: اضافه کردن دریوارهای 3مرحله 
مرحله شما تعریف می نمایید که از چه تجهیز واسطی برای ارتباط با پروسه کاری خود اسیتفاده میی   در این 

است کیه در پیرژوه خیود     PLCنمایید. درایوری که شما انتخاب می نمایید وابسته به آن سیستم کنترل یا 

 هستند. WinCCو  PLCای میان  استفاده می نمایید. درایورها رابطه

  نجام دهید:عملیات زیر را ا
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در ساختار درختیی راسیت کلیلیک     Tag Managementروی آیکون  PLCبرای افزودن یک درایور 

 را انتخاب نمایید. Add New Driverنموده و آیتم 

را از دیالوگ باکسی که بالا می آید انتخاب نموده و کلید  SIMATIC S7 Protocol Suiteکانال  -1

Open  .را کلیلک نمایید 

 راست کلیک نمایید. MPIکانال روی بر  -2

 کلیک نمایید. New Connectionاز منوی ظاهر شده روی گزینه  -3

را  Okرا در فیلد مربوطه تایپ نموده ودکمیه   PLC1عبارت  Connection Propertiesدر کادر  -4

 کلیک نمایید.
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 تگ ها و گروه بندی تگ ها: -2-4

از تگ ها استفاده می نماید تیا   WinCCهیزات دیگر هستند. و یا تج PLCتگ ها موقعیت های حافظه در 

(، استفاده خواهیم نمیود. تیگ   Internal Tagبه تصاویر حیات دهد. ما در پروژه خود، از تگ های داخلی )

واقعی را ایجاد می  PLCهستند که عملکردی مشابه با یک  WinCCهای داخلی موقعیتهای حافظه داخل 

متصل می  WinCCهستند که به  PLC( موقعیتهای حافظه در Process Tags) نمایند. تگ های فزایندی

گردند. تگها می توانند یا بصورت گروهی و یا بصورت منفرد زیر هر اتصال ایجاد شوندو شما می توانید به هر 

 تعداد که بخواهید گروه تعریف نموده و به هر تعداد که می خواهید تگ در هر گروه تعریف کنید.

 

واقعی انتساب یابنید.تگهای فرینیدی    PLCی داخلی نیز براحتی می توانن ایجاد شده و سپس به یک تگها

تگهایی هستند که بطور واقعی داده ها را در فرایند اتوماسیون مانیتور می نمایند.بعنوان مثال می توان سطح 

حافظیه آنیالوگ داخیل     پر شونده یک تانک را بعنوان یک تگ تعریف نمود. این تگ می تواند یک موقعیت

PLC .باشد که این داده ها را مستقیماً از یک سنسور در تانک جمع آوری می نماید 

 

بیاز نماییید و    Internal Tagرا تا ناحیه  Tag Managementبرای تعریف یک تگ داخلی سلسه مراتب 

 را انتخاب نمایید. New Tagروی آن راست کلیک نمایید تا منوی باز شده و سپس 
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 :ساخت یک تگ داخلی 4مرحله  -2-4-1

 کلیک نمایید تا زیر شاحه های آن باز شوند. Tag Managementبر روی  -1

 راست کلیک نمایید. Internal Tagsبر روی گزینه  -2

 را کلیک نمایید. New Tagاز منوی ظاهر شده گزینه  -3

 ام تگ تایپ نمایید.را به عنوان ن TankLevelعبارت  Tag Propertiesدر کادر  -4

ن را Okانتخاب نموده و دکمیه   Unsigned 16-Bit Valueاز لیست مربوط به نواع نوع داده ها گزینه  -5

 نید.کلیک ک

همان طور که دیدیدمی توانید به سادگی با انجام مراحل فوق یک تگ داخلی ایجاد نمایید. شما همچنین می 

 ید.نمای Pasteو   Cutو Copyتوانید تگ ها را 

 

 

 : ساخت یک گروه بند ی تگ4مرحله   2-4-2
برای مرتب سازی و سازماندهی تگ ها استفاده می شود برای ساخت یک گروه بندی مراحل زیر را به ترتیب 

 انجام دهید.

 که در مراحل قبل ساخته شده کبیک راست نمایید. connectionبر روی  -1

 ید.را کلیک نمای New Groupاز منوی ظاهر شده گزینه  -2

 Okیک نام دلخواه را به عنوان نام گروه تایپ نمایید و دکمیه   Tag Group Propertiesدر کادر  -3

 را کلیک کنید.

 مذکور قرار می گیرد. Connectionگروه بندی تگ ایجاد شده به عنوان یک زیر شاخه از 
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 : ساخت یک تگ فرایندی 4مرحله  2-4-3
ود را ایجاد نمایید، می بایست که یک درایور مناسیب را  قبل از این که شما بتوانید تگ های فرایندی خ

 نصب و پیکربندی نمایید.

 Connectionتمامی تگ هایی که به عنوان تگ های داخلی ساختید می توانیید کپیی کیرده و درون    

 نمایید. Pasteفوق  ساخته شده

 نمایید.ساخته شده مرحله قبل کلیک راست  Connectionبر روی برای ساخت یک تگ فرایندی -1

 را انتخاب نمایید. New Tagاز منوی ظاهر شده گزینه  -2

 یک نام دلخواه برای تگ تایپ کنید. Tag Propertiesدر کادر  -3

 از لیست انواع داده ها ،نوع دادهی مورد نظر خود را انتخاب نمایید. -4

 شید. با PLCمی تواند متفاوت از نوع داده های استفاده شده در  WinCCنوع داده ی یک تگ در  -5

 WinCCرا بیه ییک فرمیت در      PLCمی توانیم فرمت داده ی  format adaptationار طریق 

 تبدیل نمایید.
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 تعیین آدرس تگ ها:

خواهد شد به ترتیب زییر   PLCبرای تعیین آدرس دهی تگ ها که منجر به خواندن و نوشتن مقادیر در 

 عمل می کنیم:

جهت  Selectروی دکمه  Tag Propertiesدر پس از طی مراحل فوق جهت ساخت یک تگ در کا -1

 تعیین آدرس آن تگ کلیک می کنیم.

 نوع تگ را انتخاب می کنیم. dataاز قسمت   Address Propertiesدر کادر  -2

 را کلیک می کنیم. OKرا تعیین کرده و دکمه   Address typeنوع  Addressاز قسمت  -3
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 تعیین مقیاس خطی تگ ها:
اسیت   PLCطی زمانی که شما بخواهید یک مقدار تگ فرایند را که متفاوت از همان مقدار در مقیاس خ

 استفاده می شود.

خود به خود تغییر نمی کند، مقیاس خطی فقط بیرای تیگ هیای     (PLC)مقداری از مقدار فرایندییک 

 .فرایندی استفاده می شود

و  Process value Rangeای ورودی را علامت بزنید تا فیلیده  Linear Scalingتیک مربوط به  -1

Tag Value Range .فعال شوند 

را  Tag Value Rangeوارد و مقادیر   20 تا-  20را از  Process value Rangeمقادیر مربوط به   -2

 وارد نمایید. 100تا  0از 

تیگ   وارد نمایید یک Process value Rangeمثبت و منفی را برای توجه: اگر شما می خواهید مقادیر 

 Format Adaptationرا از قسمت  Signedمشخص کنید و گزینه  data typeعلامت می بایست در 

 انتخاب نمایید.
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 ساخت صفحات فرایند:  1-5مرحله 

 
 

نمایش می دهند که این کار از طریق سیسیتم گرافیکیی    runtimeصفحات مقادیر فرایند را در حالت 

 این فصل شما صفحات فرایند را طراحی خواهید کرد. صورت می گیرد. در

را باز نموده و مراحل زیر را بیه ترتییب دنبیال     Graphics Designer،  برای ساخت یک صفحه جدید

 نمایید:

در پنجره سمت راست آن کلیک راست نموده و گزینه  Graphics Designerپس از کلیک بر روی  -1

New Picture ایل تصیویری بیا پسیوند    را انتخاب نمایید. یک ف.pdl (Picture Description 

File به نام )NewPdl0.pdl .ساحته می شود 

 را برگزینید.  Rename Pictureراست کلیک نموده و گزینه  NewPdl0.pdlبر روی فایل  -2

 تایپ کنید. START.pdlنام این صفحه را  -3

 یجاد نمایید.ا SAMPLE.pdlصفحه دوم این پروژه را با طی مراحل فوق به نام  -4

 

 : Graphics Designerدر نحوه کار بر روی صفحات 

باز کردن این فایل بر روی آن دابیل کلییک نماییید تیا وارد      و START.pdlصفحه برای مشاهده  -1

 شوید. Graphics Designerمحیط 
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بر روی آن راست کلییک نمیوده و گزینیه     START.pdlهمچنین شما می توانید جهت باز کردن فایل 

Open Picture .را بر گزینید 

 

 : Graphics Designerمحیط  2-5-2
می شوید تصویری به صورت زیر از این محیط را مشاهده  Graphics Designerوقتی شما وارد محیط 

 حواهید کرد.

 :(Color Paletteپالت رنگ)

شما میی   رنگ استاندارد موجود 16با انتخاب اشیا این قسمت صورت می گیرد. علاوه بر  تنظیم رنگ ها 

 توانید رنگ های سفارشی دیگری نیز تعریف و استفاده نمایید.

 

 :(Object Paletteپالت اشیا )

 :این پالت شامل

 Standard Objects : ( برای ترسیم اشکالی از جملهPolygon, Ellipse, Rectangle,etc.  ) 

Smart Objects  برای استفاده از :OLE Control, OLE Element, I/O Field, etc 

Windows Objects  برای استفاده از :Button, CheckBox, etc 

 

 :(Style Palette)پالت حالت 

ظاهر اشیا انتخاب شده را تغییر می دهد. بسته به نوع شی شما می توامنید نوع ، حالت یا پهنای خط ییا  

 حاشیه و همچنین تغییر رنگ زمینه اشیا استفاده می شود.

 

 (:Alignment Paletteپالت تنظیم)

 به شما اجازه می دهد که موقعیت یک یا چند شی را تغییر دهید، تغییر موقعیت اشیا انتخابی 

 

 (:Zoom Paletteپالت بزرگ نمایی)

تنظیم درصد بزرگ نمایی در این پالت صورت می گیرد ، از طریق دکمه ها چندین بزرگ نمایی و کوچک 

 ند.نمایی به صورت پیش فرض قابل تنظیم هست

 

 (:Menu Barنوار منو)

 می باشد Graphics Designersفرمانی شامل همه منوهای 

 

 (:Toolbarنوار ابزار )

 شامل دکمه هایی برای دسترسی سریع به برخی فرامین می باشد.
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 (:Font Paletteپالت قلم)

( Standard Objectsبرای تغییر نوع، اندازه و رنگ اشیا متنی و همچنین رنگ خطوط اشیا استاندارد)

 می باشد.

 

 (:Layer Bar)لایه نوار

به صورت پیش فرض جهیت انجیام    0لایه قابل مشاهده و انتخاب هستند. لایه شماره  32در این قسمت 

 .ترسیمات و برنامه نویسی انتخاب شده است

 

تخیاب از  نمایش داده شیوند بیا ان   Graphic Designerتوجه: تعیین  اینکه کدام نوارها یا پالت ها در 

بیاز   Toolbarsصورت می گیرد. با انتخاب این گزینه مادری تحت عنیوان   View → Toolbarsمنوی 

می شود که توسط آن می توانید هر نوار یا پالت دلخواهی را انتخیاب کنیید و ییا از حاالیت انتخیاب در      

 را بزنید. OKبیاورید و در پایان جهت اعمال تغییرات دکمه 

 

 دصفحه فراین  3-5-2

برای اولین پروژه مان ، شمایل یک تانکر آب را در صفحه قرار می دهیم. همه اشیا گرافیکی میورد نییاز   

موجود هستند. ما همچنین در این پروژه احتیاج به ییک   WinCC libraryبرای استفاده در صفحه در 

Button  یک ،Static text  و یکinput/Output field .داریم 

 

  Buttonیک : ساختن  5-2مرحله  4-5-2

برویم پیکر بنیدی   Runtimeکه ما را قادر می سازد به صفحه دیگری در حالت  Buttonدر ابتدا، یک 

جا به جا  SAMPLE.pdlو  START.pdlمی کنیم. در ادامه خواهید آموخت که چگونه بین دو صفحه 

 شویم.

سیر زیر را م Object Paletteاز قسمت  Button،جهت قرار دادن یک  START.pdlدر صفحه  -1

  Button   Windows Object →دنبال کنید:

 Buttonبر روی صفحه بر روی این شی راست کلییک نمیوده و گزینیه     Buttonقرار دادن پس از  -2

Configuration .را انتخاب می کنیم 

 تایپ می نماییم. Buttonرا به عنوان نام این  SAMPLEعبارت  Textاز کادر باز شده در قسمت  -3

 Change Picture onکیه در قسیمت     بیر روی دکمیه    SAMPLEبرای سوییچ به صفحه  -4

Mouse Click   کلیک می نماییم.می باشد 

 را انتخاب می نماییم. SAMPLE.pdlصفحه مورد نظر یعنی  Picturesاز کادر  -5

 دکمیه  ه را کلیک می نماییم و برای ذخیره موارد انجام شد OKپس از انجام مراحل فوق دکمه  -6

 کلیک می نماییم. Start.pdlرا در صفحه 
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 دوم Buttonساخت 

بازگشیت   START.pdlبتوانیم بیه صیفحه    SAMPLE.pdlاز صفحه  Runtimeبرای انکه در حالت 

 START.pdlپیکر بندی می کنیم که ما را به صفحه  SAMPLE.pdlکنیم دکمه دیگری را در صفحه 

 زیر را به ترتیب انجام می دهیم. منتقل می کنیم برای این کار مراحل
 

 

 

 پیکربندی صفحه فرایند 5-5-2
 (Water Tankساختن یک تانک آب )

1- Graphics Deesigner   از نوار منیو ،View > Library      در   را کلییک نماییید ییا آیکیون

Toolbar .را انتخاب نمایید 

2- Global Library        ه پوشیه  را دابل کلییک نماییید و سیپس در پنجیره سیمت راسیت بیPlant 

Elements می رویم. 

 دبل کلیک نمایید. Tanksبر روی پوشه  -3

کلیک نمایید تا پیش نمایش همگی تانک های موجود در  Library Toolbarاز  بر روی آیکون  -4

 کتابخانه را مشاهد نمایید.

 

یش اشییا را تغیییر   نوار ابزار کتابخانه می توانید سایز پیش نما  از و  توجه: از طریق دکمه های 

 دهید.

 

5- Tank1 را انتخاب و به محیط ترسیم بکشید و رها نمایید (Drag & Drop). 

 و با سایز دلخواه جا به جا نمایید. توسط ماوس تانک را به موقعیت دلخواه -6

 

 (Pipingساختن لوله کشی )

ب های لوله ها و انشعا Plant Elements → Pipes–Smart Objects  → Global Libraryاز -1

 مورد نیاز را انتخاب و به درون صفحه منتقل نمایید.

2- Plant Elements → Valves–Smart Objects  → Global Library   یک ولو مناسب را بیه

 درون صفحه منتقل نموده و در جای مناسب قرار دهید.

 

اسیتفاده شیوند    و یا اشیای دیگر که ممکن است در یک ترسیم زییاد  توجه: اشیایی مانند زانوی لوله ها

منتقل شوند و شیما میی توانیید ییک شیی را       Libraryنیازی نیست که هردفعه و بصورت جداگانه از 

Copy-Paste  نمایید و یا اینکه بر روی آن شی راست کلیک نموده و گزینهDuplicate  را برگزینید تا
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)چرخانیدن( و   Rotateین همان شی را برای شما کپی نماید و همچنین شما می توانید یک شی  با فرام

 قابل استفاده هستند. Arrange( از منوی Mirrorوارونه)

 

 (Static Textساختن یک متن ثابت )

1- Object Palette → Standard Objects → Static Text  نموده و درجای مناسب در را انتخاب

 .صفحه ترسیم قرار دهید

 تایپ نمایید. Static Textرا برای  Atlanta Water Supplyعنوان  -2

انیدازه قلیم را    از ابیزار   Toolbarتنظیم نمایید، ) از منوی ، 20اندازه قلم نوشته را روی  -3

 تنظیم نمایید(
 

 :  5-4مرحله  6-5-2

با مقدار ییک تیگ سیاخته میی شیود، در واقیع        Propertiesیک شی دینامیک بر اساس ارتباط یک 

 ند ویژگی از یک شی می شود.تغییرات مقدار یک تگ باعث تغییر در یک یا چ

( بر روی آن شی کلیک راسیت  Object( یک شی )Propertiesبرای نمایش یا تغییر ویژگی های ) -1

 نمایید. در این مرحله بر روی شی تانک راست کلیک می کنیم.

 را برگزینید. Propertiesاز کادر باز شده گزینه  -2

 
 

قرار دارد شما می توانید پنجیره   Propertiesپنجره که در نوار ابزار  توجه: با کلیک بر روی دکمه 

Properties    را با رفتن به اشیا مختلف ثابت نگه دارید، یعنی اگر شما یک شی دیگری انتخیاب نماییید
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در میی   . در این حالت دکمه فوق به شکل ویژگی های آن به صورت اتوماتیک نمایش داده می شود

 ین عمل را انجام می دهیم.آید، برای برگشت به حالت قبل عکس ا

 

ویژگی های یک شی می توانند تغییر کنند، برای مثال شما می توانیید   Object Propertiesدر پنجره 

( و مقدار مینیمم یا میاکزیمم را  Height( و طول ) Width) رنگ ها و موقعیت های مکانی از جمله پهنا

 تنظیم نمایید.

 کلیک نمایید. Tag Assignmentدر سمت چپ پنجره بر روی  -3

که در مراحل قبل ساخته شد می بایسیت بیه عنیوان ییک مقیدار       TankLevelدر پروژه ما، تگ  -4

 Tag، بیدین منظیور در طیرا راسیت پنجیره      دینامیک به سطح پر شونده تانیک متصیل شیود   

Assignment    از قسمتFill Level   بر روی سطرDynamic .راست کلیک می کنیم 

 را انتخاب می نماییم. Tagینه از منوی ظاهر شده گز -5

 
 

را  OKرا انتخاب و دکمه  TankLevelتگ  List of all Tagsاز قسمت  Tags-Projectدر کادر  -6

 یک لامپ سبز رنگ نمایان می شود( Fill Levelکلیک می کنیم.) با انتخاب این تگ، در سطر 

ل به روز رسانی تگ فوق ، مقدار سیک Fill Levelاز سطر  Update Cycle (Current)در ستون  -7

 Uponثانیه تنظیم شده است، بنا بر این در این قسمت راست کلیک نموده و گزینیه   2برابر مقدار 

Change .را بر گزینید 
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تنظیم شیده   100و  0به ترتیب با مقادیر  Fill Levelتنظیمات پیش فرض برای مقادیر مینیمم و ماکزیمم 

 اند.

دهنده یک اتصال بین یک تگ و یک صفت از یک شی می باشد.در پروژه لامپ سبز رنگ نشان توجه : 

 می باشد. Fill Levelمتصل به ویژگی  TankLevelما تگ 

به صورت پر رنگ نمایش داده می شود بیانگر اتصال یک تیگ بیه ایین     (Propertyوقتی یک ویژگی )

 .ویژگی می باشد
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 دینامیک:  I/O Field: ساخت یک  5-5مرحله  7-5-2

قرار دارد نیز می باشد، ایین فیلید فقیط     Fill Levelکه در بالای   I/O Fieldفرایند شامل یک  صفحه

استفاده نمی شود، بلکه برای تغییر مقیدار ایین تیگ نییز میورد       TankLevelبرای نمایش مقدار تگ 

 استفاده قرار می گیرد.

   I/O Fieldک ساخت ی

1-  Object Palette → Smart Objects → I/O Fieldو بیه صیفحه ترسییم     را انتخاب می کنیم

 انتقال می دهیم

بیه صیورت اتوماتییک     I/O Field Configuration،کادر صفحه ترسیم  به I/O Field با انتقال  -2

 ظاهر خواهد شد.

را از قسیمت   Tanklevelکادری باز می شود کیه از طرییق آن تیگ     با کلیک بر روی دکمه  -3

Internal Tag  نیم.انتخاب می ک 

ایین   Update انتخاب کنید)بدین منظور از لیست کشویی ms 500را برابر  Update Cycleزمان  -4

 را کلیک می کنیم. OKو در پایان دکمه   مقدار را انتخاب کنید(
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 Configurationپنچره  I/O Field)کشیدن و رها کردن( یک  Drag & Dropاگر شما هنگام توجه: 

م نداده اید تیک باز می شود را ببندید در حالی که بسیاری از تنظیمات آن را انجاآن را که بصورت اتوما

را انتخیاب   Configuration Dialogراست کلیک نمیوده و گزینیه    I/O Fieldمی توانید بر روی آن 

 نمایید.

 

 دینامیک I/O Fieldساختن یک 

 تغییر داد Object Properties Windowریق را می توان از ط I/O Fieldویژگی های یک 

 را برگزینید. Propertiesموردنظر راست کلیک نمایید و گزینه  I/O Fieldبر روی  -1

 کلییک نمایید. Limitsبر روی ویژگی  در پنجره سمت چپ -2

 دابل کلیک نمایید. Low Limit Valueبر روی  در سمت راست پنجره -3

 نمایید.را کلیک  OKرا وارد نمایید و دکمه  0از کادر باز شده عدد  -4

 دابل کلیک نمایید. High Limit Valueدر سمت راست پنجره بر روی  -5

 را کلیک نمایید. OKرا وارد نمایید و دکمه  100از کادر باز شده عدد  -6

 

نمیودیم، اگیر شیما بیر روی      متصل Input/Outputیک تگ را به ویژگی  هانطور که قبلاً انجام دادیم

میلیی  500سیکل بروزرسیانی  را با زمان  Tank Levelتگ کلیک نمایید شما  Input/Outputویژگی 
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انجام داده  I/O Field Configurationشما این تنظیمات را از طریق کادر در واقع ثانیه خواهید دید 

 اید.

کلییک نماییید و    ار بیر روی دکمیه   ییییی یره نمایید بیرای اینک یییرا ذخ START.pdlصفحه 

Graphic Designer   راminimize یید.نما 

 

 Runtime: تعیین ویژگی های حالت 6مرحله  6-2

برای انجیام   برای این پروژه را خواهید آموخت. Runtimeدر این قسمت شما تعیین ویژگی های حالت 

 اینکار مراحل زیر را به ترتیب انجام دهید:

 کلیک نمایید. Computerبر روی آیکون  WinCC Explorerدر سمت چپ پنجره  -1

 ظاهر شده بر روی نام کامپیوترتان راست کلیک نمایید. در سمت راست پنجره -2

 را برگزینید. Propertiesاز منوی ظاهر شده گزینه  -3

کلیک نمایید. در اینجا شما می توانید نحوه نمیایش محییط    Graphic Runtimeبر روی سربرگ  -4

Runtime پروژه خود را تعیین نمایید. 

ای اجرا شیود از طرییق کلییک بیر روی دکمیه       برای اینکه مشخص نماییدپروژه شما با چه صفحه -5

Browse  و انتخاب صفحهSTART.pdl    این کار را انجام دهید و در پاییان دکمیهOK   را کلییک

 نمایید.

 Title, Maximize, Minimizeتیک های مربوط به آیتم های  Window Attributesدر پنجره  -6

 انتخاب نمایید.را  Adapt Pictureو 

 
 

، شما اکنون می توانید در حالیت  خارج شوید Propertiesکلیک نمایید تا از پنجره  OKبر روی دکمه 

Runtime .به ادامه کار بپردازید 
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 (Activating The Projectاجرای پروژه )مرجله  7-2

گزینییه بییر روی  WinCC Explorer در  Fileمنییوی از  Runtimeدر حالییت  بییرای دیییدن پییروژه

Activate .لامت ع کلیک نمایید   در کنارActivate  بیانگر حالتRuntime .بودن پروژه می باشد 

 

 WinCC Explorerنرم افزار  Toolbalکه در  در روشی دیگر، شما می توانید با استفاده از دکمه 

 کردن پروژه نمایید. Activateقرار دارد اقدام به 

 

 وید:ویر زیر روبرو می شفحه، شما با تصشدن ص Loadجهت  اندکیمدت زمان صرا بعد از 

 
 (Simulator: استفاده از شبیه ساز ) 8مرحله  8-2

را برای تست پروژه اتان  Simulatorبرقرار نباشد، شما می توانید از  WinCCو  PLCاگر ارتباط بین 

 استفاده نمایید:

 مسیر روبرو را دنبای نمایید: Simulatorبرای استفاده از  -1
Start → SIMATIC → WinCC → Tools → WinCC Tag Simulator 
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 Simulator( تا بتوان از نیرم افیزار   Runtimeباشد) Activateتوجه: یک پروژه می بایست در حالت 

 برای شبیه سازی تگ ها استفاده نمود.

 

خاب نمایید بدین منظیور از منیوی   یییک تگ یا چند تگ را می بایست انت Simulatorدر پنجره  -2

Edit → New Tag گزینید.را بر 

 را کلیک نمایید. OKرا انتخاب و دکمه  TankLevel، تگ داخلی  Tags-Projectدر کادر  -3

 کلیک نمایید. Incبرای تعیین نوع شبیه سازی بر روی  Propertiesدر سربرگ  -4

 در فیلدهای مربوطه وارد نمایید. Stopرا برای   100و مقدار  Startرا برای  0مقدار  -5

 ت بزنید.را علام activeچک باکس  -6

 TankLevelتگ  Tagsکلیک نمایید.جدول  Start Simulationبر روی دکمه  Tagsدر سربرگ   -7

 به همراه مقدار در حال تغییر آن را نشان خواهد داد.را 

 
 

بیرای صیفحه شیما     Simulatorخواهید دید که چگونیه   برگردید، شما Runtimeاگر شما به صفحه  

 د.مقادیر واقعی را تولید می کن

 → Fileدرآوریید بیرای اینکیار از منوبیار فرمیان       Deactivateبه حالت  WinCCپروژه را در  -7

Activate  را اجرا نمایید. مشاهده می کنید که علامت   از کنار گزینیهActivate    برداشیته میی

 شود.
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 فصل سوم

 نمایش مقادیر فرایند

 

 
 Tag Loggingو نحوه پیکربندی ویراستار  وداین فصل اجزای پایه سیستم آرشیوسازی را معرفی خواهد نم

نمیایش داده میی    Trendو پنچره  پردازش مقادیر فرایند در جدول Runtimeرا خواهد آموخت. در حالت 

 شوند.

 

 وظایف سیستم آرشیوسازی
شما می توانید مقیدار ییک تیگ را    مثلاً  شما می توانید مقادیر جاری فرایند را در هر زمان مشاهده نمایید.

نییاز  مقادیر قبلی فراینید   برای نمایشبرای اینکار شما به یک جدول  راساس تاریخ مشاهده نمایید و غیره.ب

 ، این مقادیر در سیستم آرشیوسازی فرایند ذخیره می شوند.دارید

 

 آرشیوسازی اجزای سیستم

زییر   Runtime اجیزای و  پیکربندییک سری نیازمند  ،سیستم آرشیوسازی مقادیر فرایندبرای استفاده از 

 می باشید.

 

مقیدار  در اینجا شما میی توانیید   می باشد. Tag Loggingرشیوسازی ویراستار آسیستم  پیکربندیمحیط 

سیکل زمانی آرشیوسازی و انتخاب مقادیری که میی بایسیت آرشییو    فرایند را ارشیو نمایید، نحوه تعریف و 

 شوند در این ویراستار صورت می گیرد.

بودن پروژه مقادیری که می بایست آرشیو شوند   Runtimeدر طول  ستم ارشیوسازیسی Runtimeاجزای 

 را دریافت و ذخیره می کنند.
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 تم آرشیوسازپیکربندی سیس
 ، موارد زیر را نجام دهید:Tag Loggingبرای پیکربندی 

  Tag Logging ویراستار باز کردن -1

 پیگربندی یک تایمر -2

   Archive Wizardیق آرشیوساز از طر ساخت یک -3

 پیکربندی آرشیوساز ساخته شده -4

 Graphic Designerدر  Trendساخت یک پنجره  -5

 Graphic Designerدر  Tableساخت یک پنجره  -6

 Startupتعریف پارامترهای  -7

8- Activate نمودن پروژه 

 

 

 Tag Logging: باز کردن 1مرحله 1-3
 

جمیع اوری   کسب و آرشیوسازی سیکلی جهترها ، مقادیر فرایند با پیکربندی تایم Tag Loggingدر 

 می شوند.

 راست کلیک نمایید. Tag Logging، بر روی  WinCC Explorerدر پنجره سمت چپ  -1

 را برگزینید. Openاز منوی باز شده گزینه  -2
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 : پیکربندی تایمرها2مرحله 2-3

 
انند جهت پیکربندی سییکل  تایمر ها می تو خط دوم واقع شده است. شی تایمر دردر سمت چپ پنجره 

 .مورد استفاده قرار گیرند(Archiving) آرسیوسازی تگ ها( یا Acquisition)دریافت تگ ها

 
 

را  فرایندتگ  یکیمرهای درونی هستند که مقدار ا( تAcquisition Cyclesتوجه: سیکل های دریافت )
 می خواند.

 

فراینید  قیدار ییک تیگ    منی هستند که ( تایمرهای دروArchiving Cyclesسیکل های ارشیوسازی)

 دریافت می باشد.  دخیره و ارشیو می کنند.سیکل آرشیوسازی همواره مضرب صحیحی از سیکل

 

نماییان  سمت راسیت  در پنجره  کلیک نمایید، همه تایمرهای پیش فرض Timersاگر شما بر روی شی 

میی   ا را تغییر دهید. اگر شماتحت هیچ شرایطی نمی بایست مقادیر پیش فرض این تایمره.خواهند شد

خواهید از تایمری استفاده نمایید که زمان آرشیو سازی آن متفاوت با این تایمرهاست شیما م یتوانیید   

 یک تایمر جدید را ایجاد و پیکربندی نمایید.

 برای مثال با طی مراحل زیر شما می توانید یک تایمر هفتگی را پیکربندی نمایید:

 

 است کلیک نمایید.ر Timersبر روی شی  -1

 را برگزینید. Newاز منوی باز شده گزینه  -2

 را به تایمر بدهید. Weeklyنام  Timer-Propertiesدر کادر  -3

 .را برگزینید Day 1 مقدار از لیست باز شوندهو  Baseدر قسمت  -4

 نمایید. OKرا تایپ نمایید. ودر پایان کادر موجود را  7مقدار  Factorدر قسمت  -5
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   حاصل می شوند. Factorو  Baseهای دریافت یا ارشیوسازیاز ضرب دو عدد توجه: سیکل 

 

 

 : ساخت یک آرشیوساز3مرحله  3-3

 
 Archiveآرشیوسازی مقدار فرایند و انتخاب تگ ها جهت آرشیوسازی با کمیک  ، Tag Loggingدر 

Wizard .ساخته می شوند 

Archive wizard  شد.باروش ساده و مناسبی جهت ساخت ارشیو می 

 کلیک نمایید. Tag Loggingدر پنجره سمت چپ  Archivesبرای ساخت آرشیو، بر روی  -1

 را برگزینید. …Archive Wizardاز منوی باز شده گزینه  -2

 را انتخب نمایید. Nextدر اولین کادر باز شده، دکمه  -3

 را تایپ نمایید. TankLevel_Archiveنام  Archive Nameدر فیلد  -4

 برگزینید. Process Value Archiveنوع آرشیو را  -5
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 یید.را کلیک نما Nextکار دکمه  ادامهدر 

برای تاییید  انتخیاب نماییید.  از کادر باز شیده  را  TankLevelرا کلیک نموده و تگ  Selectدکمه  -6

 را کلیک نمایید. OKورودی های داده شده دکمه 

 پایان پذیرد. Archive Wizardپیکربندی شما از طریق  را کلیک نمایید تا Applyدکمه  -7
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 : پیکربندی یک آرشیو4مرحله -4-3

 
 پیکربندی خواهید نمود. در این مرحله، شما ارشیو سازی یک مقدار از فرایند را 

، در ایین پنجیره راسیت     Table Windowبرای تغییر ویژگی های تگ آرشیوی انتخاب شده در  -1

را  Table Windowد، اولین تگ در جیدول  . هیچ تگی نمی بایست انتخاب شده باشکلیک نمایید

 .انتخاب نمایید

 را برگزینید. Propertiesاز منوی باز شده گزینه  -2

 
 تغییر دهید. TankLevel_Arch  تگ آرشیوی را بهنام  -3

 ، مقادیر روبرو را وارد نمایید: Cycleدر قسمت  -4

Acquistion=1 Second                                    Archiving=1*1 Second 
 را کلیک نمایید. OKبرای تایید مقادیر وارد شده دکمه  -5

 

 .استفاده می شود Runtimeآرشیو مقدار فرایند فقط در حالت 

 
ینییید اآرشییییو مقیییدار فر بیییر روی Archivesو از قسیییمت  Tag Loggingدر پنجیییره  -6

TankLevel_Archive کادر  دابل کلیک نمایید، تاProcess Value Archive Properties  باز

 شود.

 کلیک نمایید. Memory Locationروی سربرگ  -7

 مفید می باشد. تغییر دهید. در این پروژه این سایز 30را به  data recordsسایز  -8
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 را کلیک نمایید. OKبرای تایید مقدار وارد شده دکمه  -9

 
 

هر ییک   TankLevelتگ در واقع مقدار این پایان پیکربندی ارشیو مقدار یک تگ فرایندی می باشد. 

مکان نگهداری مقادیر آرشیوی حافظهه  آرشیو می شود. TankLevel_Archثانیه یکبار دریافت و در 

پروژه قابل نمیایش   Runtimeرشیو شده فقط در حالت ادیر آو مق ( می باشدMain Memeoryاصلی)

 هستند.

 

در  لیک نمایید. تغیییرات ک بر روی دکمه  Tag loggingبرای اعمال پیکربندی های انجام شده در 

 در بیاید اعمال خواهد شد. Activatedبه حالت  Runtimeمرحله بعدی که 

 خارج شوید. Tag Loggingاز ویراستار  -10
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 (Trend: ایجاد یک نمودار)5مرحله 5.3
 

یک کنترل در  WinCCامکان نمایش مقادیر فرایند را برای ما ایجاد می کند. بدین منظور  Trendیک 

 تیار ما قرار می دهد که با قرار دادن آن در صفحه فرایند، امکان ایجاد نمودار را خواهد داد.اخ

ایجیاد نماییید و وارد آن    WinCC Explorerدر  TagLogging.pdlیک صفحه جدید بنام  -1

 باز شود. Graphic Designerشوید تا 

 WinCC Online Trend  را کلیک نماییید و کنتیرل   Controlسربرگ  Objectدر پالت  -2

Control .را انتخاب نمایید 

 در محیط ترسیم، کنترل فوق را در جای مناسب قرار دهید. -3

را بعنوان نام نمودار وارد  TankLevel_Trendsاز کادر باز شده عبارت  Generalدر سربرگ  -4

 نمایید.

 
 

 را انتخاب نمایید. Curvesسربرگ  -5
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 یید.تایپ نما Trendرا بعنوان نام  TankLevelنام  -6

بییر روی  Archive/Tag Selectionکلیییک نمایییید و از کییادر  Selectionبییر روی دکمییه  -7

TankLevel_Archive .دبل کلیک نمایید 

 را کلیک نمایید. TankLevel_Archدر کادر باز شده سمت راست ، تگ  -8

 
 را کلیک نمایید.  OK برای تایید ورودی های فوق دکمه -9
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 : ساخت یک جدول  6مرحله  6-3

 

 WinCCبصورت جدول ایجاد می کند. بدین منظور  امکان نمایش مقادیر فرایند را برای ما  Tableیک 

یک کنترل در اختیار ما قرار می دهد که با قرار دادن آن در صفحه فرایند، امکان ایجاد جدول را خواهد 

 داد.

 WinCC Online Table  را کلییک نماییید و کنتیرل    Controlسیربرگ   Objectدر پالیت   -1

Control .را انتخاب نمایید 

 در محیط ترسیم، کنترل فوق را در جای مناسب قرار دهید. -2

را بعنیوان نیام نمیودار وارد     TankLevel_Tablesاز کادر باز شده عبارت  Generalدر سربرگ  -3

 نمایید.

 
 را انتخاب نمایید. Columnsسربرگ  -4
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 .تایپ نمایید Columnsرا بعنوان نام  TankLevelنام  -5

بییر روی  Archive/Tag Selectionکلیییک نمایییید و از کییادر   Selectionبییر روی دکمییه   -6

TankLevel_Archive .دبل کلیک نمایید 

 را کلیک نمایید. TankLevel_Archدر کادر باز شده سمت راست ، تگ  -7

 را کلیک نمایید.  OK برای تایید ورودی های فوق دکمه -8

 
 

کلییک نماییید و    ، بیر روی دکمیه    Taglogging.pdlبرای ذخیره میوارد فیوق در صیفحه     -8

Graphic Designer  راMinimize .باشد 
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 Properties Runtimeتعیین : 7مرحله  7-3
 

را در حالیت   Tag Loggingبا طی مراحل زیر اجیا زه اجیرای    Runtime Propertiesدر اینجا ما در 

Runtime .خواهیم اموخت 

 بر روی گزینه کامپوتر کلیک نمایید. WinCC Explorerدر سمت چپ پنجره  -1

 در سمت راست پنجره فوق بر روی نام کامپیوترتان راست کلیک نمایید. -2

 را برگزینید. Propertiesاز منوی باز شده گزینه  -3

 را کلیک نمایید. Startupاز کادر باز شده سربرگ  -4

 را بزنید. Tag Logging Runtimeتیک مربوط به  -5

 
 کلیک نمایید. Graphics Runtimeبر روی سربرگ  -6

را  TagLogging.pdlکلییک کیرده و صیفحه     Browseبرای انتخاب صفحه شروع، بر روی دکمه  -7

 انتخاب نمایید.

 را کلیک نمایید. OKبرای تایید موارد فوق دکمه  -8
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 کردن پروژه Activate:  8مرحله  8-3

 
را کلییک   Activateدکمیه   Runtimeالت در ح Tableو  Trendبرای مشاهده نحوه کار پنجره های 

 نمایید.

 را از مسیر زیر اجرا نمایید: Simulatorنرم افزار  -1

Start → SIMATIC → WinCC → Tools → WinCC Tag Simulator  

 انتخاب نمایید. Edit → New Tagرا از منوی  TankLevelتگ  -2

 د.کلیک کنی Incحالت شبیه سازی را بر روی  Propertiesدر سربرگ  -3

 قرار دهید. 10را برابر با  Stopو مقدار  0را برابر با  Startمقدار  -4

 را انتخاب کنید. Activeچک باکس  -5

 تا مقدار تگ فوق شبیه سازی شود.را کلیک کنید  Start Simulationدکمه  Tagsدر سربرگ  -6

 را  نمیایش  TankLevelمقدار تیگ   Trendو  Tableپنجره های  WinCCدر  Runtimeدر محیط 

 خواهند داد.

 
 نمایید. Deactivateخود را  WinCCپروژه  -7
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 4فصل 

 پیکر بندی سیستم آلارم
 

 
در این فصل شما نحوه کار با سیستم آلارم  راخواهید آموخیت و ییک سیسیتم آلارم را بیا ویراسیتار      

Alarm Logging .خواهید ساخت 

 

 وظایف سیستم آلارم
اعلام می کنند. آنها در شناسیایی و  لکرد بد و مشکلات فرایند آلارم ها به اپراتورها اطلاعاتی درباره عم

 معرفی شرایط بحرانی فرایند کمک کرده و در رفع سریع اشکال کمک می کنند.
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 اجزای سیستم آلارم

 
 می باشد: Runtimeو اجزای  پیکربندیسیستم آلارم شامل 

 د.می باش Alarm Loggingپیکربندی سیستم آلارم، ویراستار  جزء

فیراهم   WinCC Alarm Controlیک کنترل بنام  Graphic Designerبرای نمایش آلارم ها ، در 

 شده است.

 

سیستم آلارم، امکانی را برای مانیتور کردن فرایند، کنترل خروجی آلارم ها و مدیریت  Runtimeجزء 

Acknowledge )آنها می باشد.  )تایید 

 ی شوند.آلارم ها بصورت یک جدول نمایش داده م

هنگام پیکربندی، شما نحوه تریگر )شرط اتفاق افتادن( رویدادها را تعریف خواهید کرد.برای مثال ییک  

شده باشد یا اینکه مقدار فرایندی از حد تعیین  PLC –Setرویداد می تواند مربوط به بیتی باشد که در 

 شده تجاوز کرده باشد.

 

 پیکربندی سیستم آلارم

 
 Alarm Loggingباز کردن ویراستار  -1

 اجرای سیستم ویزارد برای ساخت یک سیستم آلارم. -2

 پیکربندی آلارم ها و متن آلارم ها. -3

 تعریف رنگ ها برای حالات مختلف آلارم. -4

 تعیین محدوده نمایش مقادیر تگ ها. -5

 ورود پنجره آلارم در صفحه فرایند. -6

 Startupتعریف پارامترهای  -7

8- Activate .کردن پروژه 
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 Alarm Logging: باز کردن 1رحلهم 1-4

 
 راست کلیک کنید. Alarm Loggingبر روی  WinCC Explorerدر سمت چپ پنجره  -1

 را برگزینید. Openاز منوی باز شده، گزینه  -2

 
 

  System Wizard: اجرای 2مرجله  2-4
 سیستم ویزارد روش ساده ای برای ایجاد سیستم آلارم می باشد.

را برگزینید. شما همچنین می  …Select Wizardگزینه  Fileویزارد از منوی  برای اجرای سیستم -1

 را کلیک نمایید. دکمه  Alarm Logging توانید برای اجرای سیستم ویزارد در نوار منوی

 دابل کلیک نمایید. System Wizardبر روی  …Select Wizardدر کادر  -2

 نمایید. کلیک Nextدر اولین پنجره باز شده بر روی دکمه  -3

گزینیه   System Blockاز قسمت   System Wizard: Selecting Message Blocksدر کادر   -4

Date, Time, Number   را انتخاب و از قسیمتUser text block   گزینیهMsg Txt, Error 

Location  را برگزینید و دکمهNext .را کلیک کنید 
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 ..Class of Error with Types Alarmینه گز System Wizard: Presetting Classesدر کادر 

 را ککلیک نمایید. Nextرا یرگزینیدو دکمه 
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حلاصه اجزایی که توسط ویزارد ساخته شده انید، نمیایش داده    System Wizardدر کادر پایانی  -5

 را کلیک نمایید. Apply می شوند ، برای تایید موارد فوق دکمه

 

 
 

 متن آن   : پیکر بندی پیغام آلارم و3مرحله  3-4

 
 پیغام هایی را پیکربندی خواهیم کرد. Alarm Loggingدر این قسمت ما در ویراستار 

 

 : Point of Errorو  Message Textمربوط به  User Textتغییر طول بلوک های 

 کلیک نمایید. Message Blocksگزینه  سمت چپ بر روی آیکون در پنجره  -1

 کلیک نمایید. User Text Blocksاز منوی باز شده بر روی گزینه  -2

را  Propertiesراسیت کلییک نمیوده و گزینیه      Message Textاز پنجره باز شده بر روی گزینه  -3

 برگزینید.

 را کلیک نمایید. OKرا وارد کرده و دکمه  30در کادر باز شده مقدار  -4

را  Propertiesراست کلیک نموده و گزینه  Point of Errorبر روی گزینه  dataدر همان پنجره  -5

 برگزینید.

 را کلیک نمایید. OKرا وارد کرده و دکمه  25در کادر باز شده مقدار  -6

 

 

 

 پیکر بندی اولین آلارم:

 
 شدن بیتی اتفاق افتد یک آلارم می تواند ظاهر شود. Setوقتی یک رویداد مثل  Runtimeدر حالت 

 دابل کلیک نمایید. Message Tagدر خط اول جدول، در فیلد  -1

 را کلیک نمایید. OKرا انتخاب و دکمه  TankLevelدر باز شده تگ در کا -2

 دابل کلیک نمایید. Message Bitدر همان خط اول جدول، بر روی فیلد  -3

را وارد نماییید، ایین عیدد بییانگر ایین اسیت کیه ایین آلارم وقتیی ر            2رکادر باز شده مقدار د -4

(Trigger می دهد که بیت سوم از سمت راست تگ)TankLevel ( یکSet.شود) 

 Fill Levelدابیل کلییک نماییید و میتن      Message Textدر همان خط اول جدول بر روی فیلد  -5

exceeded .را تایپ نمایید 

 دابل کلیک نمایید. Point of Error در همان خط اول بر روی فیلد  -6

 را وارد نمایید. Tankدر کادر باز شده متن  -7
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 پیکربندی دومین آلارم:

 
 را انتخاب نمایید. Add new Lineول، راست کلیک نمایید و گزینه در خط اول جد -1

 دابل کلیک نمایید. Message Tagدر خط دوم جدول، در فیلد  -2

 را کلیک نمایید. OKرا انتخاب و دکمه  TankLevelدر کادر باز شده تگ  -3

 دابل کلیک نمایید. Message Bitدر همان خط دوم جدول، بر روی فیلد  -4

را وارد نمایید، ایین عیدد بییانگر ایین اسیت کیه ایین آلارم وقتیی ر           3مقدار  درکادر باز شده -5

(Trigger می دهد که بیت چهارم از سمت راست تگ)TankLevel ( یکSet.شود) 

را  Tank emptyدابل کلیک نمایید و متن  Message Textدر همان خط دوم جدول بر روی فیلد  -6

 تایپ نمایید.

 دابل کلیک نمایید. Point of Error د در همان خط دوم بر روی فیل -7

 را وارد نمایید. Tankدر کادر باز شده متن  -8

 

 

 

 پیکربندی سومین آلارم:

 
 را انتخاب نمایید. Add new Lineدر خط دوم جدول، راست کلیک نمایید و گزینه  -1

 دابل کلیک نمایید. Message Tagدر خط سوم جدول، در فیلد  -2

 را کلیک نمایید. OKرا انتخاب و دکمه  TankLevelدر کادر باز شده تگ  -3

 دابل کلیک نمایید. Message Bitدر همان خط سوم جدول، بر روی فیلد  -4

را وارد نماییید، ایین عیدد بییانگر ایین اسیت کیه ایین آلارم وقتیی ر            4درکادر باز شده مقدار  -5

(Trigger می دهد که بیت پنجم از سمت راست تگ)TankLevel ( یکSet.شود) 

 Tank emptyدابل کلیک نمایید و میتن   Message Textن خط سوم جدول بر روی فیلد در هما -6

 را تایپ نمایید.

 دابل کلیک نمایید. Point of Error در همان خط سوم بر روی فیلد  -7

 را وارد نمایید. Pumpدر کادر باز شده متن  -8

 



 تألیف: عباس محمدی    WinCC                                                                     زار آموزش مقدماتی نرم اف

 

 

 
 

 

 : پیکربندی رنگهای مربوط به آلارم ها4مرحله  4-4

 
نمیایش داده شیود. ایین امیر در      Runtimeمی تواند در رنگ های مختلیف در محییط   وضعیت آلارم 

 شناسایی سریع وضعیت آلارم به ما کمک می کند.

 کلیک نمایید. Message Classesمربوط به گزینه  در پنجره ناوبری سمت چپ، بر روی آیکون  -1

 کلیک نمایید. Errorاز منوی باز شده بر روی گزینه  -2

راست کلییک نماییید و از منیوی بیاز شیده گزینیه        Alarmراست بر روی گزینه در پنجره سمت  -3

Properties .را برگزینید 
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 در کادر باز شده، متن و رنگ زمینه آلارم را می توانید بر اساس وضعیت آلارم پیکربندی نمایید.

 برای پیکربندی رنگ این آلارم ها به روش زیر اقدام نمایید:

 

 )زمان فعال شدن آلارم(کلیک نمایید. Came inروی گزینه بر  previewدر قسمت  -1

 کلیک نمایید. Text Colorبر روی دکمه  -2

 را کلیک نمایید. OKدر کادر انتخاب رنگ، رنگ سفید را برگزیده و دکمه  -3

 کلیک نمایید. Background Colorروی دکمه بر  -4

 ایید.را کلیک نم OKرا برگزیده و دکمه  قرمزدر کادر انتخاب رنگ، رنگ  -5

 کلیک نمایید.)زمان رفع شدن آلارم( Came outبر روی گزینه  previewدر قسمت  -6

 کلیک نمایید. Text Colorبر روی دکمه  -7

 را کلیک نمایید. OKدر کادر انتخاب رنگ، رنگ سیاه را برگزیده و دکمه  -8

 کلیک نمایید. Background Colorبر روی دکمه  -9

 را کلیک نمایید. OKیده و دکمه در کادر انتخاب رنگ، رنگ زرد را برگز -10

کلیک نمایید.)زمان تایید و شناسایی شدن  Acknowledgedبر روی گزینه  previewدر قسمت   -11

 آلارم(

 کلیک نمایید. Text Colorبر روی دکمه  -12

 را کلیک نمایید. OKدر کادر انتخاب رنگ، رنگ سفید را برگزیده و دکمه  -13

 ایید.کلیک نم Background Colorبر روی دکمه  -14

 را کلیک نمایید. OKدر کادر انتخاب رنگ، رنگ آبی را برگزیده و دکمه  -15

 را کلیک نمایید. OKبرای تایید ورودی های فوق دکمه  -16



 تألیف: عباس محمدی    WinCC                                                                     زار آموزش مقدماتی نرم اف
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 آلارم آنالوگ:  5-4

 
 : پیکربندی آلارم برای یک تگ آنالوگ: 5-1مرحله  1-5-4

 کلیک نمایید. …Add Insزینه بر روی گ Alarm Loggingویراستار  Toolsدر منوی  -1

 را بزنید. AnalogAlarmاز کادر باز شده تیک مربوط به گزینه  -2

 
 نمایش داده خواهد شد. Message Classesدر زیر منوی در پنجره ناوبری  AnalogAlarmابزار 

 را برگزینید. Newراست کلیک نموده و گزینه  AnalogAlarmدر پنجره سمت چپ بر روی گزینه  -4
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باز شده، تگی که می بایست مانیتور شود را انتخاب می نماییم، بدین منظور بر  Propertiesاز کادر  -5

 کلیک نمایید. روی دکمه 

 
 را علامت بزنید،  a message for all limit valuesتوجه: اگر شما تیک مربوط به گزینه 

ه یک تگ جدید ایجاد نمایید. در یک تگ موجود را انتخاب نمایید یا اینک Tag Selectionدر کادر  -6

 این پروژه ما یک تگ جدید ایحاد می نماییم:

کلیک نمایید و روی دکمه  Internal Tagsبر روی گزینه  Tag Selectionدر سمت چپ پنجره  -1-6

 .کلیک کنید 

 را بعنوان نام تگ تایپ نمایید. AnalogAlarmاز کادر باز شده نام  -2-6

3-6- data type روی  تگ راUnsigned 16-Bit Value .قرار دهید 

 را کلیک نمایید. OKبرای تایید مقادیر ورودی دکمه  -4-6 

آن را برگزینیید و    Tag Selectionاز سمت راست پنجره  AnaloAlarmپس از ساختن کامل تگ  -7

 را کلیک نمایید. OKودکمه 
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 : تنظیمات مقادیر محدودیتی5-2مرحله  2-5-4

 
 (Upper Limit Valueحدبالا یک آلارم ) تنظیم مقدار

 راست کلیک نمایید. AnalogAlarmبر روی تگ  Navigationدر پنجره  -1

 کلیک نمایید. Newاز منوی باز شده بر روی  -2

 
 را برگزینید. Upper Limitاز کادر باز شده دکمه رادیویی  -3

 را وارد نمایید. 90مقدار  -4

 را انتخاب نمایید. effective for bothگزینه  Hysteresisاز قسمت  -5

 وارد کنید. Numberرا برای  4مقدار  Messageدر قسمت  -6
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 را کلیک نمایید. OKبرای نایید مقادیر  فوق دکمه  -7

 

 (Lower Limit Valueتنظیم مقدار حدپایین یک آلارم )

 راست کلیک نمایید. AnalogAlarmبر روی تگ  Navigationدر پنجره  -1

 کلیک نمایید. Newبر روی  از منوی باز شده -2
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 را برگزینید. Lower Limitاز کادر باز شده دکمه رادیویی  -3

 را وارد نمایید. 90مقدار  -4

 را انتخاب نمایید. effective for bothگزینه  Hysteresisاز قسمت  -5

 وارد کنید. Numberرا برای  5مقدار  Messageدر قسمت  -6

 ک نمایید.را کلی OKبرای نایید مقادیر  فوق دکمه   -7

 خارج شوید. Alarm Loggingکلیک نموده و از ویراستار  بر روی دکمه  -8

 

 

 : ساختن یک صفحه برای نمایش آلارم6مرحله  6-4

 
 AlarmLogging.pdlرا باز نمایید و یک صیفحه جدیید بیا نیام      Graphic Designer بدین منظور

 بسازید و مراحل زیر را به ترتیب انجام دهید:

 WinCC Alarm Trendرا انتخییاب نمایییید و شییی  Controlsسییربرگ  Objectدر پالییت  -1

Control  به درون صفحه بیاورید.را 

 را تایپ نمایید. Atlanta Water Supplyاز منوی باز شده کنترل فوق عنوان  -2

 را بزنید. Displayتیک  -3
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 را کلیک نمایید. OKجهت تایید ورودی های فوق دکمه  -4

 Messageسربرگ  Propertiesاز کادر  دابل کلیک نمایید و WinCC Alarm Controlبر روی  -5

Blocks را برگزینید.  

 کلیک نمایید. User Text Blocksبر روی گزینه  -6
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 طراحی گرافیکی پروژه گرمایش یک موتورخانه صنعتی: مثال اول:

 
 هوازدا -1

 منبع آب گرم مصرفی -2

 مصارف عمومی -3

 رتیمبدل حرا -4

 HVACسیستم  -5

 بویلر -6

 منبع سوخت -7

 فاضلاب -8

 کندانسور -9
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- Global Library > Siemens HMI Symbol Library > Tanks 

- Global Library > Siemens HMI Symbol Library > Process Heating 

- Global Library > Siemens HMI Symbol Library > Pumps 

- Global Library > Siemens HMI Symbol Library > Valves 

- Global Library > Siemens HMI Symbol Library > Pipes 

 

 شدن مخزن و خالی مثال دوم: مشاهده پر
 (در این مثال فقط ما فقط تغییرات را مشاهده می کنیم و هیچگونه اعمال دستوری نداریم )

 
 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 



 تألیف: عباس محمدی    WinCC                                                                     زار آموزش مقدماتی نرم اف

 

 

 مخزن و خالی شدن: مشاهده پر سوممثال 
 ضمن اینکه تغییرات را مشاهده می کنیم اعمال دستور هم  می کنیم(ما  در این مثال فقط)

 
می فرستیم، بعد از رسیدن حجم مایع به مقدار موردنظر در  Tank 2به  Pumpبوسیله  Tank 1مایع را از 

( Valveثانیه فعال می شود و سپس شیر ) 10( به مدت Mixerمخزن دوم، پمپ خاموش شده و مخلوط کن )

انجام  Manualو   Automaticجی باز شده و مایع را به بیرون ارسال می کند. این پروسه به دو صورت خرو

 می شود.
Tank: Library > Global Library > Plant Elements > Tanks 

Pump: Library > Global Library > Plant Elements > Pumps 

Mixer: Library > Global Library > Plant Elements > Motros 

Valve: Library > Global Library > Plant Elements > Valve_Smart 

Pipe: Library > Global Library > Plant Elements > Pipe_Smart 

Button: Library > Global Library > Operation > Toggle Buttons 

 

 

 

 

 

 

 پایان نسخه اول

Tank 1 

Tank 2 

Pump 

Valve 


